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WARNING

Before the operation the device, the following procedures are required to be adhering:

1) Do not use the device if the GPRS/GSM or GPS antenna shows any visible signs of

damage.

2) Ensure that the SIM Card cover is in place after the SIM Card is being inserted for the

electrical safety of the device.
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WARRANTIES EXCLUSIVE

IF THE INFOWAVE PRODUCT DOES NOT OPERATE AS WARRANTED ABOVE, THE
CUSTOMER'S SOLE REMEDY SHALL BE, AT INFOWAVE'S OPTION, REPAIR, OR
REPLACEMENT. THE FOREGOING WARRANTIES AND REMEDIES ARE EXCLUSIVE
AND ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, EITHER IN
FACT OR BY OPERATION OF LAW, STATUTORY OR OTHERWISE, INCLUDING
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
INFOWAVE NEITHER ASSUMES FOR IT ANY OTHER LIABILITY IN CONNECTION WITH
THE SALE, INSTALLATION MAINTENANCE OR USE OF INFOWAVE'S PRODUCTS.
INFOWAVE SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS TESTING AND
EXAMINATION DISCLOSE THAT THE ALLEGED DEFECT IN THE PRODUCT DOES NOT
EXIST OR WAS CAUSED BY THE CUSTOMER’S OR ANY THIRD PERSON'S MISUSE,
NEGLECT, IMPROPER INSTALLATION OR TESTING, UNAUTHORIZED ATTEMPTS TO
REPAIR, OR ANY OTHER CAUSE BEYOND THE RANGE OF THE INTENDED USE, OR

BY INCIDENT, FIRE, LIGHTNING OR OTHER HAZARD.
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LIMITATION OF LIABILITY

IN NO EVENT WILL INFOWAVE BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF
DATA, LOSS OF PROFITS, COST OF COVER OR OTHER INCIDENTAL
CONSEQUENTIAL OR INDIRECT DAMAGES ARISING OUT THE INSTALLATION,
MAINTENANCE, USE, PERFORMANCE, FAILURE OR INTERRUPTION OF A INFOWAVE
PRODUCT, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY. THIS LIMITATION
WILL APPLY EVEN IF INFOWAVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH

DAMAGE.
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TRADEMARKS

©2004 InfoWave Pte Ltd. All rights reserved. http://www.infowavemobile.com

Microsoft, Windows, Windows CE, Windows NT, ActiveX, ActiveSync, eMbedded Visual C++,
eMbedded Visual Basic, MSDN are either registered trademarks or trademarks of Microsoft

Corporation in the United States and/or other countries.

XS8cale™ Intel, Pentium are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries. TIM GPS Receiver Protocol
Specification application note are from u-BLOX Corporation. AT Command Set for MC 55

Siemens Cellular Engine document are from Siemens Corporation.

Contents are subjected to change without prior notice. The products mentioned herein are a
registered trademark of InfoWave Pte Ltd. All other trademarks belong to their respective

owners.
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ABSTRACT

This document gives a detailed account on the Waveon738 product’'s setup, installation,
usage and troubleshooting. The setup procedures entail the whole installation of the
peripherals and cables with the MT and the cradle with illustrated pictures. In the later
sections the procedures such as saving registry settings to the on-board Flash disk, DOC,
configuration of the buttons, creating dialup connection to GPRS (General Packet Radio

Service) etc., will be discussed.

The contents of this paper also describe some brief but comprehensive procedures for the
application programmers to follow while customizing software functions to suit their needs.
The source codes cited in this paper are C Language. Some of the important embedded
Visual C++ APIs is discussed pertaining to the sound drivers, port controls, communication
etc. Lastly, in the FAQ Section, some common questions posed by customers such as setting

application to run at startup etc will be answered.

ID: 81-010-008-012 Page 9 Confidential
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NOTATIONAL CONVENTIONS

i. In this documentation, Waveon738 is referenced as W738 or Mobile Terminal (MT)

and the Server end is referred to as host.

ii. The mobile station (MS) represents the GPRS module plus SIM Card. The module
excluding SIM card is known as Mobile Equipment (ME). The computer or PDA is known as

Terminal Equipment (TE)

iii. In this document, the notation “->" is used to refer to a command selected from a
menu. E.g. Open command on the File menu is File-> Open. The programming sections are

denoted by (PROGRAMMING SECTION)

ID: 81-010-008-012 Page 10 Confidential



InfoWave

...the next Wave

LIST OF FIGURES

Figure 1
Figure 2
Figure 3
Figure 4
Figure 5
Figure 6
Figure 7
Figure 8
Figure 9
Figure 10
Figure 11
Figure 12a
Figure 12b
Figure 13
Figure 14
Figure 15
Figure 16
Figure 17
Figure 18
Figure 19
Figure 20
Figure 21
Figure 22
Figure 23
Figure 24

Figure 25

Front View of Waveon738 MT

Rear View of Waveon738 MT

GPS Antenna

Power Cable

26 pin Data Cable

GPRS / GSM Antenna

Mounting Bracket

Swivel Joint Bracket

Cradle Board Rear View

Cradle Board Front View

System Setup Overview

Installing SIM Card (i)

Installing SIM Card (ii)

Installing Battery

Connecting Cradle Board to MT

Screwing the Mounting Bracket onto the MT Rear
Mounting the Swivel Joint Bracket onto the Flat Panel
Connecting GPRS Antenna to the MT Port
Connecting GPS Antenna to the W738 Cradle GPS Port
Typical Mounting of MT in the Vehicle- Front View
Typical Mounting of MT in the Vehicle- Rear View
Pasting the Antennas onto the Window Screen & Dashboard
Vehicle Mount of the MT

GPS Window

Button Configuration Window

Input Port Connection Diagram

ID: 81-010-008-012 Page 11

Confidential



InfoWave

...tha next Wave
Figure 26 Output Port Connection Diagram

Figure 27 Mobile Device Folder

ID: 81-010-008-012 Page 12 Confidential



InfoWave

...the next Wave

LIST OF TABLES

Table 1 Package List

Table 2 Software Features Table

Table 3 I/O Control Function Prototypes

ID: 81-010-008-012 Page 13

Confidential



InfoWave

...the next Wave

CHAPTER 1
INTRODUCTION

1.1 Product Brief

Learning from the past experience in the design and manufacturing of the In-Vehicle Terminal
over the recent years, Infowave Pte Ltd has developed the latest generation of the Mobile
Data Terminal, the Waveon738 for fleet management solutions. Specially designed to meet
the high end multiple functional demands in today’s market, this state-of-art equipment is
catered for extreme conditions in any vehicles such as vibration and EMI (electromagnetic)
shielding. Its functions are multi-folded with Built-in GPS module for navigation, General

Packet Radio System (GPRS)/GSM that allows data and voice communication over the air.

Essentially Waveon738 will house the necessary functions and unique features within the

single unit and concept of add on modules to cater to different customers’ needs.

1.2 Specifications

Waveon738 (See Figure 1) utilizes the Intel XScale PXA255 400MHz RISC processor, with
Windows CE version 4.2 as the Operating System (OS) to deliver robust real time application
as well as web browsing and multimedia capabilities. In addition, large memory space has
been incorporated within the system to meet the high data storage capacity required through
on-board 64MB SDRAM, 32MB Flash ROM and optional 16 or 32 MB Disk-on-Chip. For
interface with external peripherals such as smart card reader etc, the equipment has 5 x
RS232 ports, 4 x digital input and 4 x digital output ports, 2 x USB port etc. Details on the

specifications of Waveon738 are appended in Appendix A.

ID: 81-010-008-012 Page 14 Confidential
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Mz Imgt
Figure 1 Front View of Waveon738 MT
GEMIGPRS Speaker
Artenna
L6 Poet 1 : _ uEBPorl
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USE ActiveSyne
Port
Figure 2 Rear View of Waveon738 MT
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1.3 Cradle

The Cradle board (See Figure 9a & b) extends Waveon738 product connectivity. The COM

port configuration can be referred in Appendix C.

GPS Antenna Port Powver socket

Dets Part  Deug Port
cond 4 26 -Fin

Connecior

Figure 9 Cradle Board Rear View

G0 pin mini dock
connector

Figure 10 Cradle Board Front View

ID: 81-010-008-012 Page 16 Confidential
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14 Features

The Waveon738 product has the following features instilled within as follows:
1) Ruggedised in-vehicle unit

2) Excellent touch sensitivity

3) High brightness

4) 800 x 480 high screen resolution, 16-bit color

5) External antenna connectivity for strong signal reception and propagation.
6) Integrated GPRS and GSM communication

7) Integrated GPS receiver

8) Customizable buttons function.

9) Toggle brightness setting from button.
10) Switch Terminal to Power Save Mode from software.
11) Enabled USB keyboard and mouse support.

12) Wired LAN card driver supported

ID: 81-010-008-012 Page 17 Confidential
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CHAPTER 2
INSTALLATION GUIDE

2.1 Package List

Inside the package, you should have the following as listed out in the table below:

Item | Description Quantity
Equipment

1 Waveon738 Mobile Data Terminal 1

2 Cradle 1
Mounting Bracket

3 Swivel Joint 1

4 W738 Mounting Bracket 1
Cable

5 26 Pin Data Cable 1

6 W738 power cable 1
Antenna

7 GPS Patch Antenna 1

8 GSM Dual Band Antenna 1

Table 1 Package List

ID: 81-010-008-012

Page 18
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These peripherals and cables are as illustrated in the pictures below:

Figure 3: GPS Antenna Figure 4: Power cable

Figure 5: 26 Pin Data Cable Figure 6: GPRS/GSM Antenna

Figure 7: Mounting Bracket Figure 8: Swivel Joint Bracket

ID: 81-010-008-012 Page 19 Confidential
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2.2Setting up of Waveon738 System

2.2.1 Standalone Setup Overview

After you have checked the package list, set up the system as illustrated in the block diagram

below. Refer to Section 2.3.2 to 2.3.6 for detailed installation on the vehicle mount of the MT.

GPRS Antenna Port — | Battery Slot

Us8 - Port 2 [l = USE - Part 1

| —

QMNIOFF Swvitch

O S card Slat

h W738 MDT L tam vk

PCMCES Shot

| I —
-

Soft Reset Switch

30 Pin mini-Dock
Male Connectar
USB Active Sync Port

I—I—SD pin mini-Cock

Female Cannectar
CRADLE
GPS Antenna Pot ——©
| E—
Paower Input
COM 4
26 Pin Data Dehug Part
Connector

Figure 11 System Setup Overview

The installation procedures are as follows:

1) Install the SIM card and the battery to the MT.

2) Insert the MT into the cradle.

3) Connect the GPRS Antenna to the GPRS Antenna Port of W738.
4) Connect the GPS Antenna to the GPS Antenna Port of W738.

5) Lastly connect the power input supply.

ID: 81-010-008-012 Page 20 Confidential
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2.2.2 SIM Card and Battery Installation

1. Open the battery cover at the back of W738 and unscrew the screws inside.

Figure 12a Installing SIM Card (I)
2. Open the inner cover and insert the SIM card in the socket. Then screw back the

inner cover.

Figure 12b Installing SIM card (ii)

3. Open the battery cover and install the battery as shown

ID: 81-010-008-012 Page 21 Confidential
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Figure 13 Installing Battery

4. Screw up the battery cover back.

2.3.3 Connecting Cradle Board to the MT

Insert the 80P mini dock male connector from the MT to the cradle board’s mini dock female

connector as shown in the figure below.

Figure 14 Connecting cradle board to MT

Ensure that the cradle board and the MT are connected firmly.

2.3.4Mounting Bracket Assembly

Before mounting onto the car, the mounting bracket has to be mounted as follows:

1) Align the Mounting Bracket to the four mounting holes at the back of the MT.

ID: 81-010-008-012 Page 22 Confidential
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Then align the Swivel Joint Bracket to the Mounting Bracket and tighten with M4

screws and washes as depicted in the diagram below:

Figure 15 Screwing the Mounting Bracket onto the MT Rear

3) Lastly mount the whole assembly done in step 2 to a flat panel as shown:

Figure 16 Mounting the Swivel Joint Bracket onto the Flat Panel

ID: 81-010-008-012 Page 23 Confidential
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2.3.5 GPRS and GPS Connectivity

1) Connect the GPRS Antenna to the MT GPRS antenna port as illustrated:

Figure 17 Connecting the GPRS Antenna to the MT Port

2) Then connect the GPS Antenna to the rear of cradle as shown:

Figure 18 Connecting GPS Antenna to the W738 Cradle GPS Port

3) The complete W738 system setup is done.

ID: 81-010-008-012 Page 24 Confidential
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2.3.6 Vehicle Installation

Refer to following steps below:

1) Access a suitable mounting location within the vehicle. Note: ensure that the location

will not obstruct any other peripherals within inside.

Figure 19 Typical Mounting of MT in the Vehicle- Front View

R

Figure 20 Mounting of MT in the vehicle — Rear View

ID: 81-010-008-012 Page 25 Confidential
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2) For both the GPRS and GPS antenna, they can be pasted onto the front windscreen

or dashboard with the adhesive tape provided at the back of the antenna respectively.

Figure 21 Pasting the Antennas onto the Window Screen & Dashboard

3) Connect the Power cable to the car battery and the data cable to corresponding car
peripherals. Hide the cables carefully after installation is done. The below block diagram

shows the overview of the whole vehicle installation.

GPRS
Antenna
GPS
Antenna
£l
W738 MDT
CRADLE
0
PERIPHERALS BATTERY
26-Pin Data Cable Power Cahle

Figure 22 Vehicle Mount of the MT — Block Diagram

ID: 81-010-008-012 Page 26 Confidential
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CHAPTER 3
WAVEON 738 DEVELOPMENT OVERVIEW

3.1Requirements for Development

Our W738 firmware utilizes the Intel XScale PXA255 400 MHz processor, with Windows CE
v4.2 as its OS. The software development tool used for the application design is Microsoft
embedded Visual C++ 4.0, using an integrated development environment (IDE). The SDK
offers the familiar environment of the Microsoft Win32 application programming interface
(API), built-in support for communication etc. which are discussed in the later sections.
ActiveSync is also provided for easy connectivity between the desktop and the embedded
device, using USB port.

For installation of Microsoft embedded Visual C++ 4.0, the following hardware requirements
are as follows:

1) Desktop PC with a Pentium - || Class processor. 450 MHz or faster

2) 96 MB (128 MB recommended) memory for Windows 2000 Professional or Windows
XP Professional. 192 MB (256 MB recommended) memory for Windows 2000 Server

3) CD-ROM drive compatible with multimedia desktop PC specification.

4) VGA or higher resolution monitor required. A Super VGA monitor is recommended.

5) Adequate Hard Disk space (200 Mbytes is required).

The software requirements for installation of Microsoft embedded Visual C++ are: Microsoft
Windows® 2000 Professional SP2, Microsoft Windows 2000 Server SP2, or Microsoft

Windows XP Professional are the supported Operating systems

3.2 Setting up of the Development Environment

To ensure the functionality of the software development environment, the installation

procedures are recommended to be in the following order:

ID: 81-010-008-012 Page 27 Confidential
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1) Install Microsoft® embedded Visual C++ 4.0. For software download, refer from this
following website:

http://www.microsoft.com/downloads/

2) Install the Platform SDK (Waveon738 SDK).

3) Install Microsoft® ActiveSync™ 3.7.1.

3.3 Compiling embedded Visual C++

1) Start embedded Visual C++.

2) Create a new workspace.

3) Select a WCE configuration such as Waveon738.

4) Insert your code files and compile or build.

5) To add a new supported configuration for the current platform to your project, choose

Configuration from the Build menu and add a new platform.

ID: 81-010-008-012 Page 28 Confidential
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3.4 Software Support for Waveon738

3.4.1 Value-Added Services

W738 provides the following features as depicted in Table 2 below:

No. Features Benefits for Customer

1. Customized Power | B Can Save all current working environment with high
Management, ie. add | power consume device like LCD backlight, audio off, thus
extra Power Save mode | the driver can switch back working stage and make the
into kernel peripherals immediately.

2. Restore System Registry | B Restore back all previous setting like touch screen
Data when system cold | calibration, volume and all application configuration data, so
boot user do not need to reinstall all applications after total power

off or battery flat

B Make terminal more reliable and recoverable, because
even terminal hangs or work in uncertain status, driver can
cold reset the terminal to go back normal work state without
disturb engineer.

B Restore everything after car/truck repair.

3. Run Autoexec.bat | B Do not manually copy all files from flash ROM to system
command script when [ RAM and manually launch them
system boot up
ie. B Restart every tasks without manually set up even if user

1. Automatically copy all
necessary files from
Flash ROM to RAM

2. Auto copy all the demo
application shortcuts to
the desktop as well as to
launch the applications

press reset button

B Make terminal more reliable and recoverable, because
even terminal hangs or work in uncertain status, driver can
warm reset the terminal to go back normal work state
without disturb service engineer.

ID: 81-010-008-012
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No. Features Benefits for Customer
4, GPRS/GSM auto switch B Customer can use voice call to contact driver while
application connect to backend server through GPRS
i.e. Switch to voice mode | connection
and answer the phone
call when there’s | B Backend server can call in without ring, and then send
incoming call arrives. If | back any voice inside the car without driver's notice.
GPRS is still connecting,
after the phone call, the
GPRS connection will be
restored.
5. Auto set brightness level | B Do not bother driver to change the brightness under
according to the different | different sun shine condition like daylight, evening.
time periods
B Save power supply.
B Extend LCD lifespan.
6. Restart terminal from | B Application wants to restart terminal if it cannot decode
application the server IP from DNS server by VB Winsock ActiveX

component.

Table 2 Software Features Table

ID: 81-010-008-012
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CHAPTER 4
HOW-TO RESOURCES

4.1 Power On the Device

4.1.1 Turn on Waveon738

After the power connection has been completed, switch on the unit. To enter power save

mode, press the Power Button on the front panel of the unit and can be resumed by clicking

the same button again. Both LCD screen and the backlight will be off (Note that the MT is still

alive). Switch off the device only if not in use.

4.1.2 Debug Port

W738 can use any one of the COM ports 5,6,8,9,0 for debug message output. These COM

ports are through 26 pin connector in the cradle board. The pin assignment for the 26 pin

connector is given in APPENDIX E. The debug cable connection is shown in APPENDIX F.

The port settings required at the host PC side are

Bits per Second = 115200

Data Bits = 8
Parity = None
Stop Bits = 1

Flow Control = None
The command used to output the debug string is
WriteDebugString(int portNo,char *str);

Eg; WriteDebugString (5, "Testing...\r\n");

This command outputs the string “Testing...” to the COM port 5.

ID: 81-010-008-012 Page 31
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4.2 Run GPS Applications

4.2.1 GPS Reset

When the MT is turned on, the GPS Receiver is reset using an active low signal (Reset_N) on
the Reset Pin of the GPS module for a minimum of 1 ps. This signal is also being used in

Push-to-Fix Mode for waking up the MT and requested a position fix.

Port Setting

GPS uses COM port 7 and the GPS device works at the baud rate of 9600 bps.

4.2.2 Using GPS Application

1) Ensure that you have the GPS antenna plugged in as and placed the antenna in line

of sight with the satellites.

>
2) Double click on CEGPS @ icon on the WInCE desktop or double click on My
Computer -> Windows -> CEGPS Icon.

3) The GPS Application Window will pop up as shown below:

Satellites: l_ Quality: l_ Directian:

Latitude(ddmrm.mmmr): I—
Longitude{dddmm.mrmmm}: l—
MSL Altitude(heters): [
Date(ddmrmysy): I—
Time(hhmmss.sss): I—
Speediknaots): ’78peed(kmfh): l—

Course{degree):

Figure 23 GPS Window

4) Click on Open GPS button. GPS NMEA Protocol appears within the Current GPS

use text box and relevant GPS information such as the date, time, latitude, longitude, speed,

ID: 81-010-008-012 Page 32 Confidential
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satellites etc will appear in each field box. To verify the validity of the GPS data, you can

compare the date or time against the current UTC time or date

5) Click on Close GPS button when done.

4.3 Connect to the Internet via General Packet Radio Service (GPRS)

Network

4.3.1 Port Setting

GPRS in W738 uses COM port 1 and 3.COM port 1 is full functional UART and can
be used for voice calls, CSD calls, fax calls and GPRS services and for controlling the
GSM engine with AT commands.COM 3 is 4-wire serial interface which includes
only the data lines /TXD1 and /RXD1 plus /RTS1 and /CTS1 for hardware

handshake. This port can be used for indication of incoming calls while in GPRS

session.
4.3.2 Install SIM Card

To install SIM card follow procedures described in section 2.2.2

After the SIM card has being inserted, you must reboot the system for its initialization.

4.3.3 Reset GPRS
GPRS engine can be reset using the application ResetGPRS . exe. To reset the GPRS engine

run ResetGPRS.exe in the windows folder

Tips: Use AT Commands to check SIM Card (PROGRAMMING SECTION)
You can do the following to check the GSM network,

1) At WinCE Start Menu, select Run.
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2) Enter ‘TTY 1" in the edit box and click on OK. The TTY Terminal will then be

launched. If you are not able to see the signal, set your baud rate to the optimized rate:
115200 bps.

3) Enter ‘AT’. You will get OK response. Key in ATASCID next. The GPRS modem wiill
respond the ASCID: nnnnnnnnnnnnnn where n stands for the SIM card number.

4) Should your SIM card installed wrongly, the modem will respond with ‘+CME
ERROR:’ instead.

5) Alternatively you can check for your network operator using the ‘AT+COPS?’
command.

The AT commands spelt out in the steps mentioned could be found in Siemens MC55 AT

command manual.

4.3.4 Create GPRS Dialup Connection

To setup the RAS connection for your Internet Service Provider: e.g. Singnet, the steps are

as:
1) Select Start -> Settings -> Network and Dial-up Connections
2) Double click on Make New Connection Icon. The Make New Dial up Connection

window will be popped up.

3) Enter your connection name as for e.g. My Singnet Connection. Then select Dial-up
connection for your connection type. Once done, click on Next.

4) Select GPRS modem installed on COM 1. Then click on the Configure Option.
‘Device Properties’ window will be popped up. At the Port Settings Tab, set your baud rate,
data bits, stop bits, etc to your preferences.

5) Click on Call Options Tab next. You will see that you have the option to include extra
initialization commands. Enter \Q3+CGDCONT=1,"”IP”,”Internet”, where Internet is the APN
(access point name). This string setting is provided from your GPRS service provider. The AT
Command \Q3 is used to enable hardware handshake control (RTS/CTS). Refer to Appendix
B for the rest of GPRS APN Settings.

6) Next select TCP/IP Settings Tab. Under the Name Servers, Enter your server name if

your GPRS Service Provider requested for it (Additional command ATASGAUTH=1 for PAP
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authentication is required for some TELCO GPRS servers. So the extra command string shall

be: \Q3+CGDCONT=1,”IP”,”Internet”; ASGAUTH=1

7) Click on Next for the Telephone Number Input. Enter *99***1# in the telephone
number field. Click OK.

8) Run the application SaveReg.exe. It will save the new system registry to the
DiskOnChip. Cold- Reboot the system for the new configuration to take place.

9) On the system, Double click on Start -> Settings -> Network and Dial-up Connections
-> ‘My Singnet Connection’ to connect to GPRS provider's IP server. You can use the
application: ping command to ping for the IP address.

10) Enter your user name and password. Click on Connect Button to dial up to the
network. If the connection fails, click on the dialing properties and choose the appropriate

local area or country code.

Tips: GPRS Connection by User Application (PROGRAMMING SECTION)

The steps are as depicted below:

1) After the system boots, GPRS engine will be launched automatically.

2) The engine will then read the GMT time and set the MT system time accordingly.
GSM module time will also be set to this timing with AT command ‘AT+CCLK=.... .

3) If the software application cannot retrieve the GMT time after the GPRS connection, it
can still retrieve the server time from the remote server. Then the system GMT time is set
accordingly.

4) The time zone is set with this API:

BOOL SetTimeZone Information

( const TIME_ZONE_INFORMATION *1pTimeZoneInformation );

5) If the SIM card is being inserted, the software will start to read its number with the AT
command:

#define CMD_MODEM_GET_SIM_CARD_ID “AT~SCID\r\n”

6) Inside the software loop, the Network Operator ID as well as Network Signal Strength
are also retrieved with the following AT commands:

#define CMD_MODEM_GET_NETWORK_OPERATOR “AT+COPS?\r\n”
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#define CMD_MODEM_GET_SIGNAL_QUALITY “AT+CSQO\r\n”

7) Once they are captured, the modem will determine if the signal quality is acceptable
and network operator ID is valid, then the application breaks the loop and uses RAS to dial up
the remote server in the Internet.

8) Now the GPRS communication is up.

4.4 Use DOC Applications

4.41 DOC Introduction

In the beginning, we have highlighted that W738 has an On-Board Flash ROM of 32 MB and
64 MB SDRAM. For the ROM itself, it has an integrated Flash disk (DiskOnChip) called
“DOC” (32 MB), which enhanced the development of the applications. However, the DOC
can’t be used for limitless write times and its speed is slightly slower (1.4 MB/s for reading &

600 KB/s for writing) than RAM. DOC can be used to store applications.

4.4.2 Formatting DOC

1. Goto Start ->ControlPanel->Storage Properties .
2. Then select “Disk on chip” in the store info combo box.
3. Then click Format to format the DOC. Once formatted, all data will be lost as well as

the Registry Backup Data. Users have to restart for the settings to take effect.

4.4.3 Save Changed Registry Settings

You may realize that after you have adjusted the window settings and does a reboot. The
settings had changed back to the default which is not what you have wanted. This is because
the configuration of the window settings is stored in the On-Board Flash ROM, unlike in the
desktop PC where the settings (e.g. time, sound etc) are stored permanently in the hard disk
itself. Whenever W738 is booted, all the programs will be mapped from the ROM to the

SDRAM. To save the altered settings, follow the procedures stated below. To create

ID: 81-010-008-012 Page 36 Confidential



InfoWave

...tha next Wave
additional folder, you are required to insert the Autoexec.bat file with the command line:

mkdir.

1) Change your settings.

2) Then click on Start -> Window Explorer. Inside the folder, run the program
SaveReg.exe.

3) Wait until the windows Save Registry success pops up. Click Ok in the popped up
window. This will save your changes into the DOC.

4) So the next time you reboot your system the new registry settings will automatically

take effect.

4.4.4 Edit Autoexec.bat (PROGRAMMING SECTION)

Inside the DOC Folder, there is a sub folder: DoNotDelete. In this DoNotDelete folder, you
can add the Autoexec.bat file. Take note that you are required to uncheck the hidden file
extension for the file to show the .bat extension. Follow the steps below:

1)Double click on the DOC Folder, then double click on DoNotDelete Folder.

2) Rename the file name Autoexec.bat to Autoexec.ixt.

3) Edit the Autoexec.txt file. For example, you can create additional folder or avoid booting of

some unwanted applications as follows:

@echo Run Autoexe.bat now, please wait...
copy \DOC\Need2Copy\*.* Windows
copy \IDOC\Need2Copy\*.Ink Windows\Desktop

4) Rename the Autoexec.txt to Autoexec.bat.

Now each time the system in Cold booted autoexec.bat file will run.

4.5 Use Button Applications

4.5.1Reset Button

Software Reset
Situated at the right side of W738, is the Reset Button. (Figure 2).lts function caters to the
WiInCE Software Reset. Reachable from the side with a touch pen point, simply press for the

reset to occur.
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Hardware Reset

For the system to go into Cold reboot, the SYSTEM ON/OFF Button has to be pressed to

OFF and then to ON. (The Power ON/OFF Button is at the left side of the Unit). (Figure 2)

4.5.2 Buttons Functions at Application Level

W738 has five Operation Button Functions seated at the front display, four of which are user
customized (Buttons 1 to 4). The middle button is the Power ON/OFF.W738 also has 2

emergency buttons. The button functions for these buttons can be customized as:

1) Page Up or Page down (all 4 directions)
2) Brightness Control

3) Volume Setting

4) Keyboard Launch

5) Dial up application etc

4.5.3 Configure Buttons (PROGRAMMING SECTION)

The buttons can configured as your own application launchers or otherwise. The procedures
are as follow:
1) Double click on the ButtonConfig.exe on My Computer/windows folder and a

window will pop up as shown.

[ x
Bbtires Configur abion Tave l Careet | Rt |
0 el | e o e e ]
0 Ll 02 o | ¥
0 P S ol T » | S
@ G ] I (R Bz
Emergency Button L [Edt B,
@ Ermergency Button 2 [Edt Brosss,,

Figure 24 Button Configuration Window
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2) To use the buttons as arrow keys, click on the button within Use as a key panel. In

the drag down box options, select either<, T,—,{.

3) Alternatively, you can use the buttons on W738 to start an application. Click on
Browse button for Leftmost button (Button 1 of W738) and select waveontest.exe for

example.

4) Click on OK. Then a message box “Do you want to restart to take effect now?” will

pop up. Select OK.

5) Repeat step 2 or 3 for the rest of W738 Functional Buttons. There are 5 Functional
Buttons on the front panel and 2 emergency buttons however the middle button in the front

panel is not configurable. It is ON/OFF Display.

6) Close the window if you are finished with your configuration.

4.6 Configure the Audio Sound

The terminal has a Built-In Mono Speaker for audio output and for GSM Phone. Inclusion,
there is also a Microphone that can pick up signal within 2m radius range. The volume setting
can be adjusted in the WiInCE Control Panel. Once done, you have to save the configuration
to the DOC mentioned in Section 3.4.3. The sections below highlighted the use of WIinCE

APls behind the usage of sound device for our applications.
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4.6.1 Configure Sound Driver (PROGRAMMING SECTION)

Firstly you determine what drivers are available for audio I/O on the device, and then open
those drivers for recording or playback mentioned below. Then close the operation when
ended. However if the device is still playing a waveform-audio file, the close operation will fail.
Hence you have to use the waveOutReset function to terminate the playback before calling
waveOutClose.

First, retrieve the number of waveform output devices present in the system.
1) Then check out their capabilities as follows:

MMRESULT waveOutGetDevCaps ( UINT uDevicelID,
LPWAVEOUTCAPS pwoc,

UINT cbwoc ) ;
2) Open the specified waveform audio output device which you want. See below:

MMRESULT waveOutOpen ( LPHWAVEOUT phwo,
UINT uDevicelD,

LPWAVEFORMATEX pwfx,

DWORD dwCallback,

DWORD dwInstance,

DWORD fdwOpen ) ;
3) Prepare the waveform data block for playback with the API:

MMRESULT waveOutPrepareHeader ( HWAVEOUT hwo,

LPWAVEHDR pwh,
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UINT chwh );

4) After opening output device driver successfully and preparing the header file, sound
can be played by using this function for sending data blocks to the audio device:
MMRESULT waveOutWrite ( HWAVEOUT hwo,
LPWAVEHDR pwh,
UINT cbwh );
5) After the device driver is finished with a data block, free the data buffer using:
MMRESULT waveOutUnprepareHeader ( HWAVEOUT hwo,
LPWAVEHDR pwh,

UINT chwh );

6) Lastly, close the audio device file with this API:

MMRESULT waveOutClose ( HWAVEOUT hwo );

4.6.2 Change the Audio Volume, Pitch or Playback Rate (PROGRAMMING

SECTION)

The volume can be adjusted with these following APls:
1) Set the volume output with:
MMRESULT waveOutSetVolume ( HWAVEOUT hwo, DWORD dwVolume ) ;

2) Restart the waveform audio device for your changed volume settings:
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MMRESULT waveOutRestart ( HWAVEOUT hwo );

The audio I/O devices can be used to adjust the pitch and playback rate of waveform audio
data. To determine if your device supports either of these capabilities, query your device
using waveOutGetDevCaps function. Then change the settings using the functions stated

below:

1) Setting waveform pitch:

MMRESULT waveOutSetPitch ( HWAVEOUT hwo, DWORD dwPitch );

2) Setting the playback rate:
MMRESULT waveOutSetPlaybackRate ( HWAVEOUT hwo, DWORD dwRate );

4.6.3 Play Audio Files

Most audio files use the .wav file nhame extension. To play such file, you can use this API:
PlaySound. This function plays the default system sound if a specified file does not exist.
However if the default system is not defined too, PlaySound will fail to work.

PlaySound (TEXT("\SOUNDSWBELLS.WAV"), NULL, SND_SYNC);
Tips: System Sounds

The message boxes often or not pop up showing warnings or errors etc, whilst you will also
hear the system producing message sound. This is implemented by the following API:
BOOL MessageBeep ( UINT uType );

You can disable the warning though in our application from the WinCE Control Panel.
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4.6.4 Recording Using MicroPhone

To record simple audio sounds in W738, W738 has a simple recording utility
called recorder.exe in DOC folder.By default this application captures the sound for 5 seconds

in a wavefile wavrec.wav at a samplaing rate of 11.025Khz and 16 bit samples.
The default options can be changed by passing suitable arguments in the command line.
/DOC/recorder —f <filename> —t <time> -r <samplerate>

To record streaming audio Windows CE audio AP| should be used. Refer to

MSDN

http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/dnnetcomp/html/WaveInOut.asp
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4.7 1/0 Control

4.7.1 Device I/O Controls (PROGRAMMING SECTION)

To specify the type of operations to be performed by each and individual General Purpose
Input/Output (GPIO), you can use these Device I/O functions as stated in the table below.

These functions are implemented in the DLL file: “Waveon73810.dII”

Function Prototype Return Values Parameter
extern “C” UINT APIENTRY | O: failure long nPortNumber: 1,2,3,4
SetOutputPort () 1. success
extern “C” UINT APIENTRY | O: failure long nPortNumber: 1,2,3,4
ResetOutportPort ( ) 1. success
extern “C” UINT APIENTRY | 1: high long nPortNumber:
GetlnputPortState () 0: low 1: Input pin 1

2. Input pin 2

3: Input pin 3

4: Input pin 4
extern "C" UINT APIENTRY | O: Failure dummy long integer value
GetlLcdBrightnesslLevel () 1: Dim

5: Brightest

extern "C" UINT APIENTRY | O: Failure long nLevel
SetL CDBrightnessLevel () 1. Success 1 - Dim

5 - Brightest
extern "C" UINT APIENTRY | O: Failure dummy long integer value
WarmResetTerminal () 1. Success

Table 3 1/O Control Function Prototypes
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4.7.2 Connect Input Ports & Output Ports to External Device

Connect Input Port to an External Device

To connect your external device to your W738 Input Ports, you can follow the example as

illustrated below:

The diagram (See below) illustrates a possible connection to tap the ON/OFF status of an
external device (in the following example the taximeter rooftop light). The taximeter normally

has a control pin to drive an external +12V Relay (as shown below) or the rooftop light directly.

A relay is normally used to control ON/OFF of
the rooftop light l

+12 VDC +12VDC

Rooftop light L= Relay
control signal // AN
! \

Taximeter - o!
:. | ,'I é \O Rooftop

\ , light
Tap signal at taximeter rooftop light control

signal line IN1+

Cradle

IN1-

5K vee

IN+ < 10K

Input current: 4 mA max at 12 GPIN

VDC A AN ‘

Internal circuitry of MDT via Cradle

Figure 25 Input Port Connection Diagram
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Connect the Output Port to an External Device

In addition to the configuration of the Input Ports, you can configure your output ports to

control the external device as mentioned in the example below:

The following diagram shows a typical connection to control the triggering of an external
device. The OUT+ is connected to +12 VDC, and the OUT- is driven by software to
Open/Close the circuit current loop. It is recommended to have an external relay to (as

shown below) to control the external device.

Figure 26 Output Port Connection Diagram
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4.7.3 Configure LCD Brightness thru Button Function

To adjust the LCD brightness on your screen, you can double click on My Computer ->
Windows Folder -> WaveonBright.exe application or alternatively use the button on your
W738 to ‘fire’ out the LCD brightness control as mentioned in Section 3.5.3 --Configure
Buttons. After the configuration, whenever you pressed the configured button, the current
LCD brightness value will be read thru the /O Port and increment to another higher value
(higher brightness). If the max brightness (5) is read, the next value will revert to a lower

brightness of 1 and so on.

4.8 USB Device

W738 supports both USB host and USB client. USB Client is used for ActiveSync Application.

USB host port can support USB HID device and USB Storage device.

4.9 Port the Software Applications (PROGRAMMING SECTION)

W738 uses the RS-232-C standard to exchange data with serial devices and other PC by
way of a serial connection. When a serial connection is established between two devices, our
software designates one device as the DCE and the other device as the DTE. Refer to
Appendix C for the COM Ports configuration. You can write an application initialization file for

your COM Port as follows:
Config.ini:
Printer = Com 8§;

MSR =Com 2;

GPS =Com6;
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So you can just simply change the COM Port name to test your applications on any MT.

4.10 Calibrate Touch Screen

If the LCD Touch Screen doesn’t respond properly to your tap, you can do the following:

1. Select Start -> Settings ->Control Panel.

2. Double click on Stylus Icon.

3. ‘Stylus Properties’ window will be popped up. There are two submenus which you can
select. Double Tap & Calibration.

4. Double Tap option allows you to select your double tap sensitivity settings. After
which you can do a test on the adjustment. There’s no right click option here.

5. Ifthe MT is not responding properly to the tap, select Calibration menu and click on
‘Recalibrate’ to recalibrate the screen.

6. Save your settings to DOC at the end (in Section 3.4.3).
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4.11 Connect to the LAN

To connect the wired or wireless LAN between your MT and other PCs, follow the steps as

mentioned:

1) If you use wired LAN PC card, connect the cable from your office LAN to a mini hub. Then
from the hub to your desktop PC Ethernet point (Now you can see the Local Area Connection
Icon activated in WIinCE system tray. If not, double check the connection and your Ethernet
card again).

2) Then insert the LAN Card into the right slot of Waveon738 until it is clicked.

3) Connect another cable from the MT LAN point to the hub.

4) Once done, go to the control panel in WIinCE; double click on the Network and Dial up
connections Icon. Select ‘NE20001:NE2000 Compatible Ethernet Driver for NE2000

compatible Ethernet CF Card or any other Ethernet PC card device driver for WinCE 4.2.

5) Lastly, click on properties, specify your IP address and Subnet Mask ID. Under the Name

Severs, enter your DNS resolvers.

6) Double click on the IE explorer to hook up to the Internet.
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4.12 Communicate between Applications

ActiveSync provides the Mobile Devices Folder in WIinCE Explorer on your W738. This folder
provides a view of the files and folders on the W738 device. So you can move, copy, and
transfer files between your device and PC by dragging them to and from this folder. In
addition, the application manager enables you to add or remove programs from the device.
Lastly ActiveSync can also be used to debug software application on the PC and test run on

the terminal itself.

4.12.1 Connect ActiveSync Cable

From the W738 terminal USB client port connect USB mini-B to A cable with the mini-B end

connecting to the W738 and A end to the host PC.

The configuration steps are as follows:

1) First, install Microsoft ActiveSync 3.7.1 in your Desktop PC. Select any available USB
Host port as your ActiveSync Port on PC.

2) On the desktop computer, click Start, point to Programs, and then click

Microsoft ActiveSync.

3) On the File menu, click Connection Settings.

4) Make sure that the Allow USB connection with this desktop computer check box
is selected, and then click OK.

5) Connect USB mini-B cable to W738 first.

6) Then Connect USB — A end to the PC. As soon as it is connected active sync
connection should be established.

7) If the connection fails, click Connect to PC icon on the W738 desktop for connection.
8) To debug the software applications, Choose Waveon738 for your active WCE

configuration and Win32(WCE ARM) Debug for Select Active Configuration in the Microsoft
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embedded Visual C++ Program. Once the program is being built, ActiveSync will start

downloading the executable files to the mobile terminal.

9) Below illustrated a typical example of the Mobile Device Folder in your PC end.
oix|
]Fl\e Edt Wiew Favorites Tools Help |“
| 4mpeck - = - 5| Qsearch TiFolders sty | U5 I X o | B |
| address [ [ mobile Devies -] P ‘
L] B B =

ly Computer Buttor\s cedemo CeGPS
Mobile Device oofigeation

description.

eteonstress  CeteonTest cmd Connect to PC

GFRS Ml GPRS S\I’\GTE\ GPRS Stavh\.lb GSMFthe
Dialer
5 .54 -
il Px 1AL fiLi
o [v I_I

[18 abject(s) | Mabie Device

Figure 27 Mobile Device Folder

4.13 Microsoft Speech API:

The Microsoft® Speech SDK 5.0 is the developer kit for the Microsoft® Windows
environment. Tools, information, and applications are provided to help you integrate
and optimize your speech recognition and speech synthesis engines with the new
Microsoft Speech API 5.0 (SAPI 5.0). The SAPI 5.0 API dramatically reduces the
code overhead required for an application to use speech recognition and synthesis,
making speech more useable for more applications by more developers. For

documentation of Microsoft speech API, refer to

http://msdn.microsoft.com/library/default.asp?url=/library/en-

us/wcesapi/html/ceconSAPIReference.asp
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4.14 Software-Based Input Panel

W738 has a software-based input panel that functions through a touch screen. This software-
based input panel architecture is an IM that enables your application to accommodate input in
multiple forms. The Windows CE IM requires two parts: the software-based input panel
subsystem and the IMs. The primary difference between Windows CE IMs and usual
keyboard input is that an additional level of interpretation is necessary in Windows CE to
convert non-keyboard input into a keyboard event. This conversion is handled by the
software-based input panel subsystem in the OS, which also manages software input

methods.

This Soft keyboard can be invoked by clicking the red pen icon in the system tray, near the
time display in the task bar, and selecting the ‘LargeKB’. The soft keyboard can be hidden by

clicking the red icon again and selecting ‘Hide Input panel’.

4.15 Memory Allocation

By default 30MB of RAM is allocated for DATA and 30 MB of RAM for program memory. It
can be changed using control panel if necessary following the steps below:
1. Goto ControlPanel->System
2. Goto Memory Tab.
3. Slide the sliding bar accordingly to how you may want to allocate memory for
data and program

4. Save the settings using savereg.exe so that the registry settings are stored
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4.16 Microsoft Battery Status Information

This function retrieves battery status information, such as ACLineStatus, BatteryLifePercent,
BatteryLifeTime etc. This information can be used for power monitoring, e.g. detecting

whether external battery is connecting, battery voltage etc.

DWORD GetSystemPowerStatusEx2(
PSYSTEM_POWER_STATUS_EX2 pSystemPowerStatusEx2,
DWORD dwlLen,

BOOL fUpdate

);
Parameters
pSystemPowerStatusEx2
[out] Pointer to a buffer that receives power status information.
dwlLen
[in] Specifies the length of the buffer pointed to by pSystemPowerStatusEx2.
fUpdate
[in] Specify TRUE to get the latest information from the device driver. Specify FALSE

to get cached information that may be out-of-date by several seconds.

Return Values

Length of the data returned in the pSystemPowerStatusEx2 buffer indicates success. Zero

indicates failure.

For documentation of SYSTEM_POWER STATUS EX2, refer to

http://msdn.microsoft.com/library/default.asp?url=/library/en—

us/wceuid0/html/cerefsystem power status_ex2.asp

ID: 81-010-008-012 Page 53 Confidential



InfoWave

...the next Wave

CHAPTER 6

APPLICATIONS

A wide range of corporate and consumer applications are enabled by the features of this

W738 product. This section introduces some of the default applications by W738:

1) Web browsing. It has never been an enduring application for the mobile users due to
the long time taken to download the data. But with Built-in GPRS module, W738 is suited for

such application.

2) Mobile track and trace. Using Global Positioning System (GPS), anyone in a vehicle
is able to receive its satellite position and thereby know where they are. Such application can

be used for ad-hoc stolen vehicle tracking and fleet management as well.

3) Job Dispatch. Combined with vehicle positioning applications such that the nearest
available suited personnel can be deployed to serve a customer. E.g. Taxi management

system.

4) LAN Access. Users can connect W738 to the office LAN and thereby accessing,

transferring information and browsing the Net.
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CHAPTER 6

FAQ

6.1 How to Reduce Application Size while Update Application over Air?

If you have large file size and wish to reduce their size so as to reduce cost and time to

download them to your MT, you may follow our recommended approaches as mentioned

below.
1) Build the application in release version.
2) Separate the functions to different dynamic link libraries (dlls), then download

some of the upgraded dlls instead of whole application exe files from server end.

3) Put resources (bitmaps, icons, constant strings) to resource dll.

4) Use Photoshop (Menu Image -> Mode -> Indexed color) to create index color

bitmap to reduce the bitmap size to 8 bits indexed color bitmap without affecting the bitmap

outlook.
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6.2 How to Debug your Applications

There are a few modes of debugging as listed below:
1) To help locating bugs or errors in the codes in .c files etc, you can use the embedded
Visual C++ debugger. You can check the source codes line by line or from the first sentence

to the middle of source codes using the following commands:

Step into;
Run to cursor;

Go

2) You can also debug the application running on your MT after testing the application in
emulation. First you have to build a debug version of your application and download it to your
MT connected to your PC. The debugging commands are still the same. A point to note is
when you build the application on the MT, it builds all binaries on the desktop PC and then

downloads them to the device.

3) The second method will be using the PC Hyper Terminal. On your platform (desktop
PC) that supports the Console, its debug version can create a console window with a
rudimentary monitor prompt that allows you to peep inside the running application on the
mobile terminal. For enabling the Console mode, the debug com port needs to be connected
from the MT to PC. You can also send the debug message though the debug com port

example:

#include <DbgAPI.h>

#define IS_DEBUG 1

RETAILMSG (IS_DEBUG, (_T(“TEST")));
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4) The last method is to use the log file that resides in the file directory of W728 to log

and view your debug message. In your application program, you can use the CreateFile &
WriteFile API to create your own debug messages. l.e. after you compiled the application

program, the debug message will then be written into the log file.

6.3 How to make my application to run at startup?

You can have any program to run at startup by creating an autoexec.bat to run the program.
Fore.g,

To run a program xx.exe which is in windows folder, have the autoexec.bat file as
Avindows/xx.exe

Put the autoexec.bat file in the folder /DOC/DoNotDelete

Else, the registry key can be used to launch the application at startup. In the key
HKEY_LOCAL_MACHINE\Init are the entries containing executables that will be run when the
device is booted.For instance it can be assigned as follows,

Launch 10 - Shell.exe

Launch20 - device.exe

Launch 30 - gwes.exe

Depend 30- 14 00

In this case, executabes will be run in the following order shell, device and gwes.The hex
value DependXX represents the XX launch number to wait for.

6.4 Is there a program on W738 to edit registry?

Yes, there is a program called PRegEdit to edit the registry in W738.Goto Windows Folder
and click PRegedit.exe to invoke the registry editor. Alternatively you can use the remote

registry editor in EVC++ also.
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6.5 Is it possible to run applications directly from the storage card?

Users can start the application from the Storage card after the system is ready. During the
system startup, the PCMCIA slot driver will take some time to initialize the hardware and find
the storage card; so users will need to wait some time before they can start the application
from the storage card. If you were to start the application from the RAM, it will be much faster

than if it starts from the Storage card, however this option will occupy some RAM space
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GLOSSARY, ABBREVIATIONS, TERMS

Acronym Definition
APG Application Programming Guide
API Application Programming Interface
ATM Asynchronous Transfer Mode
APN Access Point Name
BPS Bits per second
CPU Central Processing Unit
COM Communication
DCE Data Communication Equipment
DOC Disk On Chip
DTE Data Terminal Equipment
DLL Dynamic Link Library
DNS Domain Name Server
GPIO General Purpose Input/Output
GPRS General Packet Radio Service
GPS Global Positioning System
GSM Global System for mobile communication
GUI Graphic User Interface
Handler Reference to the created or open file
IP Internet Protocol
IE Internet explorer
I/O Input/Output
JB Junction Box
LAN Local Area Network
MMS Multi Media Service
ME Mobile Equipment
MIC Microphone
OEM Original Equipment Manufacturer
0S Operating System
PC Personal Computer
PDA Personal Digital Assistant
RAS Remote Access Service
SDK Software Development Kit
SIM Subscriber Identity Module
SMS Short Message Service
TTS Text to Speech
WINS Windows Internet Name Service
WWW World Wide Web

ND OF DOCUMEN
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APPENDIX A TECHNICAL SPECIFICATIONS

Physical Specification | Dimension: 210mm x 140mm x 40mm
| Weight: to be defined
| Casing: Industrial Plastic, UV protection
| Flammability:UL94-V0
Microprocessor | Intel X-Scale PXA255 400MHz RISC processor
Operating System | Windows CE .NET 4.2
Memory | 32MB Flash ROM
| 64MB SDRAM
] 16 or 32MB Disk-on-Chip
Power Consumption | Input Voltage: 9 -28 Vdc ,12Vdc nominal
] Current Consumption: 2A Max
Function Buttons | 4 x programmable function buttons
| 1 x Power On/Off button
u 1 x Reset button on the side of device
Display Panel [ | 7" TFT color LCD Display
[ | 800 x 480 resolution, 16-bit color
] Resistive 4-wire touch-panel, anti-glare film
Audio [ | Built-in Speaker and Microphone
| Built-in Mobile phone ear piece jack for hands
free operation
Modem | Built-in GSM/GPRS module
[ | GPRS class 10 Triband 900/1800/1900MHz
GPRS Class B module
| Supports both voice and data communication
GPS | 12 channel GPS receiver module
| Accuracy - 15m (CEP)
| Hot/Warm/Cold start time - 8/30/45 sec
| Supports NMEA-0183 protocol
Communication and Interface | 2 x CF Slot (1 Internal)
Ports | 1 x Full handshake RS232 port
[ | 5 x R8232 ports with TXD, RXD, GND
| 4 x Digital Input ports
| 4 x Digital Output ports
| 2 x USB Host
[ | 1 x USB Client
Standard Software | Pocket Internet Explorer
| Software Development Kit (SDK)
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Operating Temperature | -20 degree Celsius to 55 degree Celsius
| -20 degree Celsius to 70 degree Celsius (w/o
G

PRS/GSM module)

Storage Temperature | -30 degree Celsius to 70 degree Celsius
Relative Humidity | 5%-95%RH

Vibration | MIL-STD-810F Basic Land Transportation
EMC [ | CE, FCC Part 15C, VCA

ID: 81-010-008-012 Page 62 Confidential



InfoWave

...the next Wave

APPENDIX B GPRS APN SETTINGS

PROVID APN
ERS

Airtel

Vodafone airtelnet.es
(Spain)

AIS Internet
(Thailand)

Amena Amenawa
(Spain) P
Aria

(Turkey) Internet

AT&T (USA) | Proxy

Aycell
(Turkey)

Beeline
(Russia)
Bite
(Lithuania)

Blu
Contratto

(Italy)
Blu

Aycell

banga

INTERNET

Prepagata |PINTERNET

(Italy)
Bouygues

Telecom www.ebouygtel.com

(France)

BPL (India) |bplgprs.com

Cellis FTML
(Lebannon)

Cesky Mobil
(postpaid)
(Czech
Rep))
Cesky Mobil
(prepaid)
(Czech
Rep))

China
Mobile cmnet
(China)

China

Unicom none
(China)
Chunghwa
(Taiwan)

internet.ftml.com.lb

internet

ointernet

wappie

Cingular
(USA)

CM Prepay
(Czech cinternet
Rep))

Connect
(Austria)

isp.cingular

web.one.at

wap.beeline.ru

USERNAME |[PASSWORD DNS 1

vodafone

®

CLIENTE

®

®

®

Beeline

®

®

®

®

bplmobile

™

®

®

®

®

®

)

R

)

vodafone

@]

AMENA

@]

@]

@]

beeline

@]

@]

@]

@]

()

()

@]

@]

@]

@]

@]

)

@]

)

193.149.2.5

202.183.255.20

213.143.33.8

212.156.4.4

212.156.4.4

194.190.195.066

213.226.131.131

212.17.192.49

212.17.192.49

62.201.129.99

202.169.145.34

212.67.64.2

212.67.64.2

10.0.2.100

168.95.192.1

66.209.10.201

212.67.64.2

DNS 2

193.149.2.13

202.183.255.21
213.143.32.20

212.156.4.20

212.156.4.20
194.190.192.034

193.219.32.13

212.17.192.209

212.17.192.209

202.169.129.40

66.209.10.202

194.024.128.100 {194.024.128.102
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Cosmote
(Greece)

CSL (Hong-
Kong)

D1 (T-
mobile)
(Germany)

DIGI
(Malaysia)
Digicel
(Jamaica)

Dna
(Finland)

DTAC
(Thailand)

EMT
(Estonia)

Entel PCS
(Chile)
E-Plus
(Germany)

ERA
(Poland)

Etisalat
(UAE)

Europolitan
(Sweden)

EuroTel
(Czech
Rep))
EuroTel
(Slovakia)
Fido
(Canada)
France

Telecom
(France)

Globe
Telecom
(Philippines)
Globtel
(Slovakia)
Hinet
(Taiwan)
HTmobile
(Croatia)

Idea
(Poland)

IM3
(Indonesia)

Islandssimi
(Island)

Jersey
Telecom
(UK)

KGT Online
(Taiwan)
KPN Mobile
(Netherland
s)

internet

internet

internet.t-d1.de

diginet

web.digiceljamaica.co
m

internet

www.dtac.co.th

internet.emt.ee

imovil.entelpcs.cl

internet.eplus.de

erainternet

mnet

none

internet

internet

internet.fido.ca

orange.fr.mnc001.mcc
208.gprs

www.globe.com.ph

internet

internet

www.htgprs.hr

www.idea.pl

www.imdosat-m3.net

gprs.islandssimi.is

pepper

internet

internet

®

®

®

®

wapuser

®

®

®

entelpcs

eplus

erainternet

Mnet

®

®

®

®

gprs

globe

®

)

®

idea

gprs

)

™

)

KPN

@]

@]

@]

wap03jam

@]

@]

@]

entelpcs

Gprs

erainternet

Mnet

@]

@]

@]

@]

)

Globe

@]

)

@]

Idea

im3

)

()

)

Gprs

195.167.65.194

202.84.255.1

193.254.160.1

203.92.128.131

217.78.192.78

203.155.33.1

217.71.33.200

212.23.97.2

213.158.194.1

194.170.1.6

192.165.99.231

160.218.10.201

194.154.230.64

204.92.15.211

203.127.225.10

213.151.200.3

10.12.01

194.204.159.1

213.176.128.51

212.9.0.135

62.133.126.29

203.116.254.150

203.92.128.132

217.78.192.22

203.44.144.33

217.71.32.20

212.23.97.3

194.170.1.7

192.165.99.232

194.228.2.1

194.154.230.74

203.127.225.11

195.12.140.130

194.9.223.79

213.176.128.50

212.9.0.136

62.133.126.29
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LibanCell
(Lebanon)

LUXGSM
(Luxembour
9)

M1
(Singapore)
Max

(Business)
(Austria)

Max (Metro)
(Austria)

Maxis
(Malaysia)
Max Mobil
(Austria)

Max Online
(Austria)

Mobilkom
(Austria)

Mobiltel
(postpaid)
(Slovenia)
Mobiltel
(prepaid)
(Slovenia)
Mobistar
(Belgium)
MTS
(Russia)

Netcom
(Norway)

New World
(Hong-
Kong)

Nordea
(Estonia)

o2
(Germany)
02 (Ireland)

o2
(Netherland
s)

02 (UK)
O2 (pre-
pay) (UK)

02 Viag
Interkom
(Germany)

Oi (Brazil)

Omnitel
(Italy)

Omnitel
(Lithuania)

OneNet
(Austria)

Optimus

isurf.libancell.com.lb

web.pt.lu

mobilenet

Business.gprsinternet

gprsmetro

internet.gprs.maxis

gprsinternet

gprsinternet

Al.net

internet

internetpro

web.pro.be

internet.mts.ru

wap.netcom.no

internet

internet.emt.ee

internet

open.internet

internet

mobile.o2.co.uk

payandgo.o2.co.uk

internet

gprs.oi.com.br

web.omnitel.it

gprs.omnitel.net

web.one.at

internet

)

®

®

®

)

®

GPRS

GPRS

gprs@aplus.at

®

®

mobistar

mts

wap

®

)

)

gprs

®

web

payandgo

®

)

®

®

)

®

)

@]

@]

@]

)

@]

()

()

()

@]

@]

mobistar

Mts

netcom

@]

)

)

Gprs

@]

password

payandgo

@]

)

@]

@]

)

@]

194.154.192.101

202.79.64.21

213.162.64.1

213.162.64.1

202.75.129.101

213.162.64.1

213.162.64.1

194.48.124.200

212.65.63.10

213.087.000.001

212.45.188.43

62.40.32.33

193.113.200.200

195.182.96.28

194.176.32.129

192.24.128.100

194.79.69.129

194.154.192.102

202.79.64.26

213.162.64.2

213.162.64.2

10.216.4.21

213.162.64.2

213.162.64.2

194.48.139.254

212.65.63.145

213.087.001.001

212.45.188.44

62.40.32.34

193.113.200.201

195.182.96.61

195.22.175.1

192.24.128.102

ID: 81-010-008-012

Page 65

Confidential



InfoWave

(Portugal)

Optus
(Australia)

Orange
(Belgium)

Orange
(Denmark)

Orange
(France)

Orange
(Hong
Kong)

Orange
(India)

Orange
(Romania)

Orange
(Slovakia)

Orange
(Switzerland

)

Orange
contract
(UK)

Orange
JustTalk
(UK)

Orange MIB
(France)

Oscar
(Czech
Rep))

Paegas
Internet
(Czech
Rep))

Paegas
Profil
(Czech
Rep))
PannonGS
M (el6f.)
(Hungary)
PannonGS
M (felt.)
(Hungary)
People
(Hong-
Kong)

Polkomtel
(Poland)

Proximus
Inter
(Belgium)

Proximus
Intra
(Belgium)

Quam
(Germany)
Radiolinja
(Estonia)

...the next Wave

int.optus.net.au

orangeinternet

web.orange.dk

orange.fr

web.orangehk.com

portalnmms

internet

internet

internet

orangeinternet

payginternet

orange-mib

internet

internet.click.cz

profil.click.cz

netx

internet

www.plusgsm.pl

internet.proximus.be

intraprox.be

quam.de

internet

®

®

®

orange

®

®

)

®

®

®

®

mportail

wap

®

®

®

®

®

®

®

®

quam

®

@]

@]

@]

orange

@]

@]

)

@]

@]

@]

@]

Mib

Wap

@]

@]

@]

@]

@]

@]

@]

@]

Quam

@]

202.139.83.3

212.97.206.131

194.51.3.49

10.11.206.51

213.55.128.1

158.43.192.1

158.43.192.1

217.77.161.131

62.141.0.1

62.141.0.1

193.225.155.254

193.225.155.254

212.2.96.62

195.238.2.21

195.238.2.21

193.189.244.192

194.204.0.1

192.65.91.129

212.97.206.161

194.51.3.56

10.11.206.50

213.55.128.2

158.43.128.1

158.43.128.1

62.141.0.2

62.141.0.2

194.149.0.157

194.149.0.157

212.2.96.52

195.238.2.22

195.238.2.22

193.189.244.205
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Radiolinja
(Finland)
Radiomibil
(Czech
Rep))
Rogers
AT&T
(Canada)

SFR
(France)
Simobil
(Slovenia)
SingTel
(Singapore)
Smart
(Philippines)
SmarTone
(Hong-
Kong)

Sonera
(Finlan)

Sonera
(Finland)

Sonofon
(Denmark)

Starhub
(Singapore)
Sunday
(Hong-
Kong)
Sunrise
(Switzerland

)

Swisscom
(Switzerland
)

TDC
(Denmark)
Telefonica
(Spain)
Telenor
(Norway)

Telering
(Austria)

Telering
(Taiwan)

Telestet
(Greece)

Telfort
(Netherland
s)

Telia
(Sweden)

Telsim
(Turkey)

Telstra
Mobiles
(Australia)

Three
(Australia)

internet

internet.click.cz

internet.com

websfr

none

internet

internet

internet

internet

internet

none

shwapint

internet

internet

gprs.swisscom.ch

internet

movistar.es

internet

web

web

gnet.b-online.gr

internet

online.telia.se

telsim

telstra.internet

3netaccess

®

®

wapuser1

®

®

®

®

®

®

®

®

®

®

internet

gprs

®

movistar

dj

web@telering.at

web@telering.at

)

)

®

telsim

®

@]

@]

Wap

@]

@]

@]

@]

@]

@]

@]

@]

@]

@]

internet

Gprs

@]

movistar

Dj

Web

Web

24680

)

@]

Telsim

@]

213.161.33.200

207.181.101.4

172.20.2.10

121.30.86.130

165.21.100.88

202.57.96.3

202.140.96.51

192.89.123.230

192.89.123.230

212.88.64.14

203.116.1.78

212.35.35.35

164.128.36.34

193.162.146.9

194.179.1.100

212.95.31.11

212.95.31.11

212.152.79.19

10.254.254.254

212.65.136.226

139.130.4.4

202.124.68.130

212.226.226.001

207.181.101.5

193.189.160.11

165.21.83.88

202.57.96.4

202.140.96.52

192.89.123.231

192.89.123.23

212.88.64.15

203.116.254.150

212.35.35.5

164.128.76.39

193.162.153.31

194.179.1.101

212.95.31.35

212.95.31.35

212.152.79.20

203.50.170.2

202.124.76.66
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TIM (Brazil) |tim.br tim Tim

TIM (ltaly) uni.tim.it WAPTIM ***) 213.26.205.1

;I;:g/lly()new) uni.tim.it ***) )

(Tl\'ﬂrgf:;s'ia) timenett.com.my " * 203.121.16.85 |203.121.16.120
;rg’\fl)'r\ltugal) internet ™ @) 194.65.3.20 194.65.3.21
T-Mobil

(Czech internet.t-mobile.cz **% )

Rep))

T-Mobile

(Netherland |internet-act ™) @) 193.79.251.39 193.79.237.39
s)

T-Mobile internet3.voicestream

(VPN) ’ ) @) 216.155.175.40 |216.155.175.41
(USA) com

T-Mobile

One20ne general.one2one.uk User mms

(UK)

T-Mobile internet2.voicestream

VoiceStrea ’ ) @) 216.155.175.170 |216.155.175.171
musa |°°M

(Tl\',\l"a;‘;‘;f;; internet " * 202.188.0.133

TransAsia . e e

(Taiwan) internet **% )

Turkcell " "

(Turkey) none ™ @) 212.252.168.240 |212.252.119.4
E/C”:o'\::llt:_i;-) gprs.vipnet.hr ™) ™) 195.29.159.15

Vodafone . " "

(Australia) vfinternet.au ™ @) 203.2.193.124 203.8.183.1
E/Gordeaefg:)e internet.vodafone.gr **% )

zllfec:::;r;e isp.vodafone.ie vodafone vodafone

Vodafone

(Netherland |web.vodafone.nl Vodafone Vodafone

s)

Vodafone

(New www.vodafone.net.nz |(¥) @) 202.20.93.10 203.97.191.189
Zealand)

Vodafone " "

(Sweden) none ) ®

Xj)lg)afone internet web Web

Vodafone . * *

(Portugal) internet.vodafone.pt ™) ™) 212.18.160.133 [212.18.160.134
Vodafone

(Omnitel) web.omnitel.it ™) @) 194.185.97.134

(Italy)

Vodafone

(Telecel) internet.vodafone.pt ™) ™) 212.18.160.133 [212.18.160.134
(Portugal)

Vodafone standardnet.vodafone

(tomédritetlen net ’ " |vodawap vodawap 80.244.97.30 80.244.96.1

) (Hungary)
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Vodafone
(tdméoritett)
(Hungary)
Vodafone
(D2)
(Germany)
Vodafone
Japan
(Japan)
VoiceStrea
m (USA)

VoiceStrea
m Central
(USA)

Westel900
(Hungary)

Wind (ltaly)

(")=anything

internet.vodafone.net

web.vodafone.de

phone

internet2.voicestream.

com

internet2.voicestream.

com

internet

internet.wind

(**)=Leave empty

(***)=Ask your provider

(***)= (you're mail@e-merge.ie)

vodawap

®

j@phone

)

)

)

®

vodawap

@]

Jphone

)

)

)

@]

80.244.97.30

139.7.30.125

61.195.195.153

216.155.175.40

216.155.175.105

194.176.224.3

212.245.255.2

80.244.96 1

139.7.30.126

61.195.194.26

216.155.175.41

216.155.175.106

194.176.224.1
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APPENDIX C COM PORT CONFIGURATIONS

Com Port

Pin No

Description

Com 1

Used for internal GPRS/GSM Module

com 2

USB client port (For ActiveSync)

Ccom 3

Used for internal GPRS/ GSM module

Com 4

CD

RXD

XD

DTR

GND

DSR

RTS

CTS

RI

Full-Functional UART (User Defined)

Com 5

1

4

NC

User defined

RXD

XD

GND

Com 6

1

]

NC

User defined

RXD

XD

QWIN|O|OWIN[O O[O [(N[O | |WIN| =]

GND

com7

Used for internal GPS Receiver

Com 8

1

]

NC

User defined

RXD

XD

GND

Com9

1

]

NC

User defined

RXD

XD

GND

ComO

1

]

~J
oo

NC

User defined

RXD

XD

QIWIN|O|OW[N|O|O1|W[IN[O]

GND

Debug Port

13,46,7,8

NC

XD

[&211\V]

GND

Debug Port for WinCE debugging
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Default COM Port Configuration Summary:

Com Port Wire No Comments

Com1 Full Internal GPRS/GSM , built-in modem
port

Com?2 USB Client ActiveSync

Com3 2 Internal GPRS/GSM , built-in modem
port

Com4 Full Any usage.

Com5 2 RX, TX. Any Usage

Com6 2 RX, TX. Any Usage

Com7 2 Internal GPS COM Port

Com8 2 RX, TX. Any Usage

Com9 2 RX, TX. Any Usage

Com0 2 RX, TX. Any Usage

- 2 RX, TX, Debug message port. Fixed
38400-8-1-n. No Name in CE
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APPENDIX D ACTIVESYNC CABLE CONNECTION

(I ] L | ]
PC W738
USB USB A USB mini-B use
HOST Client
port port
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APPENDIX E 26 PIN CONNECTOR PIN LAYOUT
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APPENDIX F DEBUG PORT CONNECTION

Connect the TX,RX and GND lines from the COM port of 26 pin connector in the cradle board

to the serial port DB-9 Female Connector as shown in figure below.
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Hereby, InfoWave Pte Ltd declares that this Waveon 738P and Waveon
738G Mobile Data Terminal, are in conformity with the following standards
and/or other normative documents.

EMC EN 301 489-1, EN 301 489-7
RF Exposure IEC 50371

We hereby declare that all essential radio test suites have been carried out
and that the above named product is in conformity to all the essential
requirements of Directive 1999/5/EC.

The conformity assessment procedure referred to in Article 10 and detailed in
Annex [IV] of the Directive 1999/5/EC has been followed with the involvement
of the Notified Body:

TIMCO Engineering Inc.
849 N.W.State Road 45, Newberry, Florida 32669 USA

Identification mark: 1177
The technical documentation relevant to the above equipment will be held at:

InfoWave Pte Ltd
600 Sin Ming Avenue 4™ Floor Singapore 575733
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European Union Regulatory Notice

This product complies with the essential requirements of following EU directive:

+ R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to applicable harmonized European
standards (European Norms) which are listed on the EU Declaration of Conformity issued by

InfoWave for this product or product family. This compliance is indicated by the following
conformity marking placed on the product:

B 1177

The equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

+» Reorient or relocate the receiving antenna
Increase the separation between the equipment and receiver
+» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected
+» Consult the dealer or an experienced radio or television technician for help

- Modifications

The FCC requires the user to be notified that any changes or modifications made to this
device that are not expressly approved by InfoWave may void the authority to operate the
equipment.

- Cables
Connections to this device must be made with shielded cables with metallic RFI/EMI
connector hoods in order to maintain compliance with FCC Rules and Regulations.

ID: 81-010-008-012 Page 76 Confidential



InfoWave

...the next Wave

As with other mobile radio transmitting equipment, users are advised that for satisfactory
operation of the equipment and for the safety of personnel, it is recommended that no part of
the human body be allowed to come too close to the antenna during operation of the
equipment.

Battery Warning

Warning: This product contains a lithium-ion rechargeable battery. To reduce the risk of fire or
burns, do not disassemble, crush, puncture, short external contacts, or dispose of in fire or
water. Replace only with InfoWave battery. Replacing with a non-approved battery will void
the warranty.

Caution: Risk of explosion if battery is replaced by an incorrect type. Dispose of batteries
according to local regulations. Do not dispose as office waste.

European Union CENELEC Waste Notice

This product complies with the following WEEE Directive 2002/96/EC:
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Privacy Information

This document and all information contained therein, is the property of InfoWave Private
Limited and thus, may not be circulated without the expressed approval of InfoWave.

Disclaimer

The information in this specification is subject to change without notice.

InfoWave Pte Ltd shall not be liable for technical or editorial errors or omissions contained
herein, nor for incidental or consequential damages resulting from the furnishing,
performance, or use of this material. This information is provided “as is” and InfoWave
disclaims any warranties, express, implied or statutory, and expressly disclaims the implied
warranties of merchantability, fithess for particular purpose, good title and against
infringement.

Warranties Exclusive

If the InfoWave product does not operate as warranted above, the customer’'s sole remedy
shall be, at InfoWave’s option, repair, or replacement. The foregoing warranties and remedies
are exclusive and are in lieu of all other warranties, expressed or implied, either in fact or by
operation of law, statutory or otherwise, including warranties of merchantability and fitness for
a particular purpose. InfoWave neither assumes for it any other liability in connection with the
sale, installation maintenance or use of InfoWave’s products. InfoWave shall not be liable
under this warranty if its testing and examination disclose that the alleged defect in the
product does not exist or was caused by the customer’s or any third person’s misuse, neglect,
improper installation or testing, unauthorized attempts to repair, or any other cause beyond
the range of the intended use, or by incident, fire, lightning or other hazard.

imitation or Liabili

In no event will InfoWave be liable for any damages, including loss of data, loss of profits,
cost of cover or other incidental, consequential or indirect damages arising out the installation,
maintenance, use, performance, failure or interruption of a InfoWwave product, however
caused and on any theory of liability. This limitation will apply even if InfoWave has been
advised of the possibility of such damage.
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Microsoft, Windows CE, Windows NT, ActiveX, ActiveSync, embedded Visual C++ MSDN
are either registered trademarks or trademarks of Microsoft Cooperation in the United States
and/or other countries.

Xscale™, Intel, are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

TIM GPS Receiver Protocol Specification application note is from u-BLOX Corporation. AT
Command Set for MC55 Siemens Cellular Engine document is from Siemens Corporation.

Contents are subjected to change without prior notice. The products mentioned herein are a
registered trademark of InfoWave Pte Ltd. All other trademarks belong to their respective
owners.

End of Document
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